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1 Getting Started

Welcome to Photozig(r) Albums, the easy, efficient and complete software to organize your digital
photos:

· Capture photos from digital cameras, scanners, hard disks and other devices
· Store, organize and retrieve photo albums easily
· Enhance your photos with cropping, red-eye buster, instant fix and other tools
· Share online, send emails, play slide shows, and create screen savers
· Backup, manage music, burn CDs, print, photo wallpaper, and much more...

Instead of conventional folders to store images, Photozig Albums has a built-in photo database that
facilitates, speeds up, and enhances your experience with digital pictures.

Photozig Albums Premium also supports short movies from digital cameras. You can transfer, store,
organize, and play short movies easily.

Before reading specific help topics, we recommend you to read about Photozig Albums
Product Family, Program Levels and Main Screens.

After program installation, the first step is to Get Photos into your new Photozig Albums.

If you have suggestions or difficulties, please click on the "Contact us" button (top right of the screen)
to get in touch with us.

Thank you for using this program. We have created it with customers in mind and we hope that you
have a wonderful experience.
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2 Changing the program level

Follow these steps to change the program level:

1. Go to the Home screen (by clicking on the Home tab in the Navigation Bar or re-starting the
program).

2. Click on the desired program level on the right bottom of the screen.

Read more about program levels.
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3 Introducing Photozig Albums

3.1 Product Family

Photozig Albums products are comprehensive personal digital media solutions that efficiently
consolidates the organization and management of your digital pictures, short videos, and songs. With
powerful, easy-to-use features, you have the tools you need to better get in control of your personal
photo/video media, helping you to speed up the personal "handling" of your digital content, so that you
have more time to enjoy and share special moments with your family and friends.

The Product Family of Photozig Albums consists of:

· Photozig Albums Express: provides all main features for digital photo organization, processing,
and sharing in one place, enabling fast, complete and efficient process to manage digital pictures.

· Photozig Albums Deluxe: includes new features, such as:

· Enhanced viewing, sorting and filtering
· Timeline album display and album preview
· Drag and drop images for Internet Explorer and other Windows applications
· Multiple albums operation: including capture, auto-naming and slide shows
· Double speed CD burning, Backup albums, and music styles
· Enhanced web albums: post higher resolution photos, private web albums, story style, and 16

extra templates
· Email higher resolution pictures

· Photozig Albums Premium: all Deluxe features with extra video capabilities:

· Capture short videos from your digital camera
· Support for .avi movies
· Support for .mpeg movies
· Play videos in the Details or Full screen
· Create and play slide shows with movies
· 16 extra web album templates

In this manual, all features of the Photozig Albums product family are described. If a particular feature
is only available for a certain product, then the product name will be mentioned between "[]", e.g.
[Deluxe, Premium].

Features from other products may be included and enabled for a limited time in your software, so that
you may try them out. Constant use of these features will require product upgrade. After you enter an
activation key, features of the corresponding product will be unlocked.

If you want to upgrade and unlock the features of other products included in your software, click on the
"Activate & Upgrade" button in the "Home" screen.
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3.2 Program Levels

Photozig Albums was designed to be friendly and fulfill the needs of different users.

You can select the program level that better suits your personal use:

· Beginner: use this program level if you don't like programs with too many options, or you are a
beginner user of computers or digital photography. All the most desirable features are shown to you
in a simple and effective way. Somewhat complex functions are hidden.

· Intermediate: this program level provides more options. Use this level if you are more adventurous
and are not afraid to experiment with more features at a time. You'll have access to filtering
capabilities, tagging, direct access to folders, Photo Basket, Thumbnail navigator and other features.

· Advanced: this level is recommended if you want to explore all the possibilities that Photozig
Albums offers, such as viewing the albums by timeline or cover photo, sorting the albums in different
manners, viewing detailed photo information, etc.

You can select the program level in the "Home" screen by clicking on the desired program level on the
right bottom of the screen.

This manual describes the features of all levels. If a certain feature is only pertinent to a certain level,
the level will be mentioned between "{}", e.g. {Intermediate, Advanced}.

3.3 Main Screens

The main screens of Photozig Albums provide easy access and functions to organize and manage
your albums and photos:

· Home: provides an overview of the process of digital photo management and allows you to perform
some key operations or go to important program screens.

· Albums: here you organize your digital albums, which may contain photos that have a common
theme or were taken at a certain time period, in a similar way of bound photo albums.

· Photos: the digital photos of an album are displayed in this screen. Also photos from a folder can be
browsed {Intermediate, Advanced}.

· Details: this screen shows a single photo of an album and contains tools to edit the photo if desired.

· Share: it allows you to share your photos in different ways, including web albums, email, CDs,
screen saver, external media, etc.
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You can go to these screens by clicking on the correspondent tab in the Navigation area or the icon in
the "Home" page.

3.4 Getting Photos First

Before managing albums and photos, the program needs to get your photos. They might be stored in
your computer hard disk, external media, or in your digital camera. Photos can also be scanned in.

In any case, the Photozig Albums software makes it easy to transfer pictures, by providing several
ways for you to choose:

· Get Photos wizard: this is the easiest way to transfer photos. Click on "Get Photos and Make
Albums" in the "Home" page and follow the step-by-step instructions.

There are shortcuts to the Get Photos wizard in the Albums screen (button in the lower toolbar) and
in the "Jump to" menu {Intermediate, Advanced}.

· Browse photos in your folders and "Create Album from Folder" or "Add Photos to Album" from
folder {Intermediate, Advanced}.

· Copy and Paste: copy a photo from an external Windows program (mouse right-click and choose
"Copy") and paste into the Photos screen an album (mouse right-click and choose "Paste").*

· Drag and drop an image from Internet Explorer and other Windows applications directly into the
Photos screen of an album [Deluxe, Premium].*

* In case of Copy/Paste or Drag/Drop, you may need to create an album first in the Albums screen, by
mouse right-click and choose "Create New Album".

After you get some photos, you will be able to see your photo albums, play slide shows, share photos
online, send emails and much more.
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4 Main Program Screens

4.1 Home Screen

Home is the main screen of Photozig Albums:

This screen shows the complete process of capturing, organizing, viewing, enhancing, and sharing
your digital photos, including:

· Get Photos: transfer photos and automatically create photo albums from you camera, scanner,
memory card, CD or the local hard drive.

· Albums: to display and organize the albums in your photo database.

· Photos: to display the photos an album or all your photos ("All My Photos" album)

· Share: to share your photos in several ways: web albums, email, CD's, memory cards, etc.

· Slide Show: to create, manage and play slide shows with photos from multiple albums [Deluxe,
Premium].

· Print: to print your photos in a selection of photo sizes.

· Activate & Upgrade: to enter the activation key and upgrade to other product of Photozig Albums
family (e.g Deluxe or Premium).

· Options: to configure the program.

· Smart Update: to check and install new version of Photozig Albums automatically.

· Extras: to access other features:

· Web Service to post pictures: to sign up for web services,retrieve forgotten user name and
password, and change settings (password, email, name, etc.).

· Backup and Restore [Deluxe, Premium]: to save and restore your albums safely to CD's or other
media.

· Browse Folders: to browse, edit and work with your photos directly in the folders of your
computer hard disk.

· Tools: to manage your photos, erase photos from  memory card.
· Music: to organize songs for slide shows.
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· Level: to select the program level: Beginner, Intermediate and Advanced.

· Exit: to close the program

You can click on the icons in your Home page to access these features.

4.1.1 What can I do with this program?

You can organize your digital photos and perform several operations:

· Create photo albums to manage your photo collection with:

· images transferred from digital cameras, scanners, memory cards, removable media and other
devices.

· images that are already in your computer hard disk.

· images from other applications (e.g. drag/drop picture from web browser) [Deluxe, Premium].

· Find a photo or album quickly.

· View photos.

· Print photos.

· Create and play slide shows.

· Share your photos with friends and family online (web albums).

· Email photos.

· Copy photos to removable media, such as memory cards to print in retail stores.

· Create a CD with photos, screensaver, and wall paper.

· Back up your albums [Deluxe, Premium]

· And much more...

4.1.2 What should I do first?

Click on the "Get Photos and Make Albums" icon in the Home screen to:

· Copy photos from an external device (such as digital camera, scanner, memory card, removable
media, etc.)

or

· Read photos that are already in the hard disk. The photos are not copied in order to save disk space,
but you can fully manage your photos after the "Get Photos and Make Albums" step.

After you perform the "Get Photos and Make Albums" step, one or more albums will be created with
your photos. During "Get Photos and Make Albums", you will be asked if you want to create multiple
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albums based on the date or location of the photos (this might be handy to start organizing your
pictures).

4.1.3 How to browse photos in the computer?

Click on "Browse Folders" in your Home screen. You will go to the Photos screen with a left panel
showing the computer folders. You can browse the folders on the left side and photos will be shown on
the right side.

You can see and work with the photos in folders, however we strongly recommend that you create an
album from a folder, so that you can use the program in an optimal way.

4.1.4 What are Albums?

Albums are digital containers of photos. Similar to regular photo albums, each digital album may
contain a group of photos that are related to a certain theme or were taken at the same time frame.

By working with Albums you don't need to worry where the photos are physically stored (which folder)
and information about photos are stored in a photo database, allowing you to find and work with photos
quickly. Albums are also automatically created for you after you "Get Photos and Make Albums".

You can organize your photos more efficiently by using Albums, instead of letting the photos being
scattered in different folders in the computer hard disk.

4.1.5 How to transfer albums from camera?

Click on the "Get Photos and Make Albums" icon in the Home screen and follow instructions.

4.1.6 How to create albums from folders?

There are two methods:

· First click on "Browse Folders" in the Home screen to start browsing folders. For each folder to be
"converted" to an album, click on the "Create Album from Folder" button.

· Click on "Get Photos and Make Albums" in the Home screen, select the option to "Get Photos from
Hard Drive, CD or other media", and follow instructions.

4.2 Albums Screen

The Albums screen shows all your albums. Here, you can create and organize your photo albums.

Similar to bond photo albums, each digital album may contain a group of photos that are related to a
certain theme or were taken at the same time frame. When you transfer or get photos from your digital
camera, scanner, hard disk, or other device in your computer, Photozig Albums can create an album
automatically for you, or you can store these photos in an existing album. You can also create an
empty album by mouse right click and choose "Create New Album".

The program creates slide shows from albums automatically when you click on the "Play Slideshow"
button. You can also mark albums as "Favorites" {Intermediate, Advanced} or place tags in a selected
album (all photos of that album) {Intermediate, Advanced}.
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There are always two special albums in your collection:

· All My Photos: this album contains all photos from all albums that you created. This album is very
useful when you want to look for particular photos quickly or perform some operations with all your
photos.

· Photo Basket {Intermediate, Advanced}: this is a temporary album which may contain photos from
different albums. This might be handy, as you can send photos to the Photo Basket when you are
browsing your albums and perform an operation in this photo set, such as play a slide show, create a
screen saver, email or send to a web album. When you send photos to the Photo Basket, the photos
actually stay in the original albums, but are referred or accessed in the Photo Basket.

Each program level has a certain screen format:

· Beginner Album screen shows a list of albums (see details)

· Intermediate Album screen also shows a list of albums, but has more options (see details)

· Advanced Album screen can display albums in several different ways and has more sorting and
navigation capabilities (see details)

You can go to the Albums screens by clicking on the Albums tab or on the Albums icon in the Home
screen.

4.2.1 Albums Screen (Beginner)

The Albums screen shows a list of your albums with the most used features to organize albums:

Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Navigation Bar:
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· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

Control Bar:

· Album Categories: shows/hides the categories of albums, allowing you to drag/drop an album to a
category, or right click on an album and choose the desired category. Photozig Albums has pre-
defined categories, but you can add, rename or delete categories.

· Quick Find: allows you to search for an album by its name quickly.

· View: here you can choose the size of the cover photos displayed in the album list.

Album List Header: allows to sort your albums. Click on "Album" to sort albums by name, on "Photos"
to sort by photo count, on "Date" to sort by album creation date, on "CD" to sort by CD backup number,
or on "Web" to sort by web albums (when photo(s) inside an album were sent to the web). If you click
on the same header element again, the sort order will be reversed.

Album List: here you can see your albums. If you double-click on an album, you open the album and go
to the Photos screen, which displays the photos of that album.

Function Buttons:

· Open Album: opens the album currently selected in the Album List. You can also open the album by
double-clicking it with the mouse or by hitting the Enter  key

· Get Photos: allows you to capture more photos from the camera, scanner, memory card, the local
hard drive or any removable media (memory cards, CDs, etc.)

· Send To Web: allows you to select photos from any album and share them with friends on the web
· Play Slideshow: displays the photos in the selected album as a full-screen slide show. If you have

songs stored in your computer you can play selected tracks along with the slide show
· More...: displays a menu with options available for the album currently selected. You can also click

an album with the right button of your mouse to get the same menu

There are different ways to see the photos of an album, going to the Photos screen of the album:

· Click on the album and click on the Photos tab of the Navigation Bar.
· Double click on the album.

You can go to the Albums screens by clicking on the Albums tab or on the Albums icon in the Home
screen.

See more information about the Albums Screen.

4.2.2 Albums Screen (Intermediate)

The Albums screen shows a list of your albums with the most used features to organize albums:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

· Jump Menu: shortcuts to most used screens:

· All albums: displays all albums in the album list
· All photos: shows all photos of all your albums
· Favorites: displays only the Favorite albums
· Get photos: goes to the screen that allows addition of photos to Photozig Albums
· Last seen: displays only the last albums that you opened recently
· Photo Basket: temporary album which may contain photos from different albums

Control Bar:

· Show tags: shows the tags panel on the left side, allowing you tag photos of an albums quickly
· Show preview: shows the preview panel of an album

· Album Categories: shows/hides the categories of albums, allowing you to drag/drop an album to a
category, or right click on an album and choose the desired category. Photozig Albums has pre-
defined categories, but you can add, rename or delete categories.

· Quick Find: allows you to search for an album by its name quickly

· View: here you can choose the size of the cover photos displayed in the album list
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· Filter: here you can select from several album filters that allow you to quickly find an album

Album List Header: allows to sort your albums. Click on "Album" to sort albums by name, on "Photos"
to sort by photo count, on "Date" to sort by album creation date, on "CD" to sort by CD backup number,
or on "Web" to sort by web albums (when photo(s) inside an album were sent to the web). If you click
on the same header element again, the sort order will be reversed.

Album List: here you can see your albums. If you double-click on an album, you open the album and go
to the Photos screen, which displays the photos of that album.

Function Buttons:

· Open Album: opens the album currently selected in the Album List. You can also open the album by
double-clicking it with the mouse or by hitting the Enter key

· Get Photos: allows you to capture more photos from the camera, scanner, memory card, the local
hard drive or any removable media (memory cards, CDs, etc.)

· Send To Web: allows you to select photos from any album and share them with friends on the web
· Play Slideshow: displays the photos in the selected album as a full-screen slide show. If you have

songs stored in your computer you can play selected tracks along with the slide show
· More...: displays a menu with options available for the album currently selected. You can also click

an album with the right button of your mouse to get the same menu

There are different ways to see the photos of an album, going to the Photos screen of the album:

· Click on the album and click on the Photos tab of the Navigation Bar.
· Double click on the album.

You can go to the Albums screens by clicking on the Albums tab or on the Albums icon in the Home
screen.

See more information about the Albums Screen.

4.2.3 Albums Screen (Advanced)

The Albums screen shows a list of your albums with the most used features to organize albums:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

· Jump Menu: shortcuts to most used screens:

· All albums: displays all albums in the album list
· All photos: shows all photos of all your albums
· Favorites: displays only the Favorite albums
· Get photos: goes to the screen that allows addition of photos to Photozig Albums
· Last seen: displays only the last albums that you opened recently
· Photo Basket: temporary album which may contain photos from different albums

Control Bar:

· Show tags: shows the tags panel on the left side, allowing you tag photos of an albums quickly
· Show preview: shows the preview panel of an album

· Previous album: goes to the previous album
· Next album: goes to the next album

· Album Categories: shows/hides the categories of albums, allowing you to drag/drop an album to a
category, or right click on an album and choose the desired category. Photozig Albums has pre-
defined categories, but you can add, rename or delete categories.
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· Quick Find: allows you to search for an album by its name quickly

· Mode: you can choose from three modes to view the albums: List,  Cover Photo or Timeline
· View: here you can choose the size of the cover photos displayed in the album list
· Sort: choose the sort order for the albums in the list
· Filter: here you can select from several album filters that allow you to quickly find an album

Album List Header: if you select the List mode to display the albums, an Album List Header will appear,
allowing you to sort your albums. Click on "Album" to sort albums by name, on "Photos" to sort by
photo count, on "Date" to sort by album creation date, on "CD" to sort by CD backup number, or on
"Web" to sort by web albums (when photo(s) inside an album were sent to the web). If you click on the
same header element again, the sort order will be reversed.

Album List: here you can see your albums. If you double-click on an album, you open the album and go
to the Photos screen, which displays the photos of that album.

Function Buttons:

· Open Album: opens the album currently selected in the Album List. You can also open the album by
double-clicking it with the mouse or by hitting the Enter  key

· Get Photos: allows you to capture more photos from the camera, scanner, memory card, the local
hard drive or any removable media (memory cards, CDs, etc.)

· Send To Web: allows you to select photos from any album and share them with friends on the web
· Backup [Deluxe, Premium]: it is very important to save your photos to a CD so that you can rest

assured your pictures will not be lost due to failures in your PC. This button allows you to burn CDs
with your photos and all the information you attached to them (album title, photo titles, descriptions,
editions, etc.) that can be restored to your Photozig Albums later on, if needed.

· Play Slideshow: displays the photos in the selected album as a full-screen slide show. If you have
songs stored in your computer you can play selected tracks along with the slide show

· More...: displays a menu with options available for the album currently selected. You can also click
an album with the right button of your mouse to get the same menu

There are different ways to see the photos of an album, going to the Photos screen of the album:

· Click on the album and click on the Photos tab of the Navigation Bar.
· Double click on the album.

You can go to the Albums screens by clicking on the Albums tab or on the Albums icon in the Home
screen.

See more information about the Albums Screen.

4.2.4 What are albums?

Albums are digital containers of photos. Similar to bond photo albums, each digital album may contain
a group of photos that are related to a certain theme or were taken at the same time frame.

By working with Albums you don't need to worry where the photos are physically stored (which folder)
and information about photos are stored in a photo database, allowing you to find and work with photos
quickly. Albums are also automatically created for you after you "Get Photos".

You can organize your photos more efficiently by using Albums, instead of letting the photos being
scattered in different folders in the computer hard disk.
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4.2.5 Why don't I see any album?

If you don't see any album in your album list, you probably did not perform the "Get Photos" step, which
will guide you through the process of transferring photos from a digital camera (or scanner, memory
card, removable media, or other device) or reading photos that are already stored in your computer
hard disk.

4.2.6 How to create an album?

If you want to create an empty album, follow these steps:

1. Click on the "More..." button (which brings up more functions)
2. Click on "Create New Album" option.
3. Enter the new name of the album in the dialog box.

The program can also create an album with pictures. The recommended method to create an album is
to use "Get Photos":

1. Click on the "Get Photos" button in the Albums screen or on the "Get Photos and Make Albums"
icon in the Home screen

2. Follow instructions.

The "Get Photos" step will allow you to create an album with:

· photos from an external device (such as digital camera, scanner, memory card, removable media,
etc.)

or

· photos that are already in the hard disk. The photos are not copied in order to save disk space, but
you can fully manage your photos after the "Get Photos" step.

4.2.7 How to rename an album?

1. Click on the desired album.
2. Click on the "More..." button (which brings up more functions).
3. Click on "Rename..." option.
4. Enter the new name of the album in the dialog box.

4.2.8 How to delete an album?

1. Click on the desired album.
2. Click on the "More..." button (which brings up more functions).
3. Click on "Erase..." option.

4.2.9 How to send an album to the web?

1. Click on the desired album.
2. Click on the "Send to Web" button.
3. Follow instructions.
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4.3 Photos Screen

The Photos screen shows the photos of an album. Here, you can see and manage the photos of an
album.

Similar to pages of a bond photo album, the Photos screen contains all the photos of an album. You
can see photos in different in different views (Tiny, Small, Medium, Super, Full Size, Tiny list, Small list,
and No thumbs list) by clicking on the View drop-down menu and selecting the desired view.
Depending on the number of photos in your album and the selected view, all photos may appear in the
screen. However, you may need to scroll down or click on the Next Photo button in the Tool Bar to see
more photos if the album contains a large number of photos or if you selected a large view..

You can also move or copy photos to another album, copy a photo to the clipping board to be pasted in
other programs, or paste a photo copied inside Photozig Albums or from other programs.

Photozig Albums Premium also allows images to be dragged and dropped (by the mouse) from
Internet Explorer and other programs into the Photos screen directly (the photo is automatically copied
to your personal photo storage)

Many other functions are available in this screen, depending on the selected program level:

· Beginner: basic view and operations on photos (see details)

· Intermediate: enhanced view of photos with Albums navigator on the left panel, with filtering and
more options(see details)

· Advanced: fully customized view of photos with more sorting capabilities and other functions
(see details)

You can go to the Photos screen by clicking on the Photos tab or on the Photos icon in the Home
screen. You can also double click on an album in the Albums screen to open that album and go to the
Photos screen directly.

4.3.1 Photos Screen (Beginner)

The Photos screen displays the photos of an album with the most used features to organize photos:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

Control Bar:

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Quick Find: allows you to search for a photo by its title or file name quickly.

· View: here you can choose the size of the photos displayed in the Photos area.

Photos:

Here you can see the photos of the album. If you double-click on a photo, you open that photo and go
to the Details screen, which displays the details of that photo.

Notice that as the mouse is over a photo, the Rotate/Hide/Delete/More bar is displayed for that photo.
You can use it to rotate, delete/undelete, hide/unhide, and perform more operations in the current
photo:
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You can use the scroll bar to see photos that are out or the screen, or use the mouse wheel. You can
open a photo for viewing or editing by double-clicking it with the mouse or by hitting the Enter key.

Function Buttons:

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.
· Rename Album: changes the name of the album currently open.
· Move/Copy: allows transferring photos from this album to another one (new or existing album).
· Remove Deleted: if you have marked one or more photos as deleted and want to get rid of them,

use this operation. The program will ask for confirmation before the photos are erased from the disk.
· More...: displays a menu with options available for the photo currently selected. You can also click

an photo with the right button of your mouse to get the same menu.

There are different ways to see the details of a photo, going to the Details screen:

· Click on a photo and click on the Details tab of the Navigation Bar.
· Double click on the photo.

You can go to the Photos screens by clicking on the Photos tab or on the Photos icon in the Home
screen.

See more information about the Photos Screen.

4.3.2 Photos Screen (Intermediate)

The Photos screen displays the photos of an album with the most used features to organize photos:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

· Jump Menu: shortcuts to most used screens:

· All albums: displays all albums in the album list
· All photos: shows all photos of all your albums
· Favorites: displays only the Favorite albums
· Get photos: goes to the screen that allows addition of photos to Photozig Albums
· Last seen: displays only the last albums that you opened recently
· Photo Basket: temporary album which may contain photos from different albums

Control Bar:

· Show hidden: shows or hides (if unchecked) the hidden photos in the current album
· Show deleted: shows or hides (if unchecked) the deleted photos in this album

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Quick Find: allows you to search for a photo by its title or file name quickly.
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· View: here you can choose the size of the photos displayed in the Photos area.
· Filter: to select to display all photos in the album or filter the photos

Albums Navigator:

This list displays the albums you have in the system. You can directly click on the album names on this
list to quickly open another album.

Photos:

Here you can see the photos of the album. If you double-click on a photo, you open that photo and go
to the Details screen, which displays the details of that photo.

Notice that as the mouse is over a photo, the Rotate/Hide/Delete/More bar is displayed for that photo.
You can use it to rotate, delete/undelete, hide/unhide, and perform more operations in the current
photo:

You can use the scroll bar to see photos that are out or the screen, or use the mouse wheel. You can
open a photo for viewing or editing by double-clicking it with the mouse or by hitting the Enter key.

Function Buttons:

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.
· Rename Album: changes the name of the album currently open.
· Move/Copy: allows transferring photos from this album to another one (new or existing album).
· Remove Deleted: if you have marked one or more photos as deleted and want to get rid of them,

use this operation. The program will ask for confirmation before the photos are erased from the disk.
· More...: displays a menu with options available for the photo currently selected. You can also click

an photo with the right button of your mouse to get the same menu.

There are different ways to see the details of a photo, going to the Details screen:

· Click on a photo and click on the Details tab of the Navigation Bar.
· Double click on the photo.

You can go to the Photos screens by clicking on the Photos tab or on the Photos icon in the Home
screen.

See more information about the Photos Screen.
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4.3.3 Photos Screen (Advanced)

The Photos screen displays the photos of an album with the most used features to organize photos:

Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

· Jump Menu: shortcuts to most used screens:

· All albums: displays all albums in the album list
· All photos: shows all photos of all your albums
· Favorites: displays only the Favorite albums
· Get photos: goes to the screen that allows addition of photos to Photozig Albums
· Last seen: displays only the last albums that you opened recently
· Photo Basket: temporary album which may contain photos from different albums

Control Bar:

· Show hidden: shows or hides (if unchecked) the hidden photos in the current album
· Show deleted: shows or hides (if unchecked) the deleted photos in this album

· Previous album: goes to the previous album
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· Next album: goes to the next album

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Quick Find: allows you to search for a photo by its title or file name quickly.

· Mode: here you can choose the mode to display photos. "Basic" mode shows only photos. "Tags"
mode shows tags on the left panel, allowing you to quickly tag multiple photos. "Albums" displays the
list of albums for you to quickly jump to different albums. "Folders" allows you to browse and work
with photos in the folders of your computer hard disk.

· View: here you can choose the size of the photos displayed in the Photos area.
· Sort By: chooses the sort order of the photos in the list. Notice that you can drag the photos with the

mouse to customize their sequence
· Filter: to select to display all photos in the album or filter the photos

Photos:

Here you can see the photos of the album. If you double-click on a photo, you open that photo and go
to the Details screen, which displays the details of that photo.

Notice that as the mouse is over a photo, the Rotate/Hide/Delete/More bar is displayed for that photo.
You can use it to rotate, delete/undelete, hide/unhide, and perform more operations in the current
photo:

You can use the scroll bar to see photos that are out or the screen, or use the mouse wheel. You can
open a photo for viewing or editing by double-clicking it with the mouse or by hitting the Enter key.

Tags Panel:

If you click on the Mode drop-down menu in the Control Bar and select Tags, the Tags Panel will
appear on the left side, allowing you to place tags on the photo quickly. This panel is also useful to
review the tags of a photo or to unbag a photo.
You can also add new tags, and rename or delete existing tags (creating a personalized tag list).

Albums Navigator:

If you click on the Mode drop-down menu in the Control Bar and select Albums, the Albums Navigator
will appear on the left side. This list displays the albums you have in the system. You can directly click
on the album names on this list to quickly open another album.

Folders:

If you click on the Mode drop-down menu in the Control Bar and select Folders, the Folders Navigator
will appear on the left side. This list displays the folders in your computer hard disk. You can directly
click on the folder to open and view the photos in this folder, allowing you to work with photos in your
folders.
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Function Buttons:

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.
· Rename Album: changes the name of the album currently open.
· Move/Copy: allows transferring photos from this album to another one (new or existing album).
· Remove Deleted: if you have marked one or more photos as deleted and want to get rid of them,

use this operation. The program will ask for confirmation before the photos are erased from the disk.
· More...: displays a menu with options available for the photo currently selected. You can also click

an photo with the right button of your mouse to get the same menu.

There are different ways to see the details of a photo, going to the Details screen:

· Click on a photo and click on the Details tab of the Navigation Bar.
· Double click on the photo.

You can go to the Photos screens by clicking on the Photos tab or on the Photos icon in the Home
screen.

See more information about the Photos Screen.

4.3.4 Why don't I see any photo?

If you don't see any photo in the Photos screen, your album is empty.

The first time that you start the program, there are only two albums:

· All My Photos: this album contains all photos from all albums that you created. (learn more)

· Photo Basket {Intermediate, Advanced}: this is a temporary album which may contain photos from
different albums, allowing you to perform an operation on these photos at once. (learn more)

"All My Photos" and "Photo Basket" albums are empty after you install the program for the first time.

If you create an empty album in the Albums screen or if you delete all pictures of an album, the album
will be also empty.

If you want to have photos in an album, we recommend you to perform the "Get Photos" step, which
will guide you through the process of transferring photos from a digital camera (or scanner, memory
card, removable media, or other device) or reading photos that are already stored in your computer
hard disk.

You can click on the "Get Photos" icon in the Home screen and follow instructions to perform the "Get
Photos" step.
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4.3.5 How to rotate a photo?

· Place the mouse is over a photo

· The Rotate/Hide/Delete/More bar will be automatically displayed for that photo to perform common
operations:

· Place the mouse over each button of this bar slowly.

· A yellow "hint" word will appear explaining the function of that button.

· When you see the desired rotate function (yellow hint), click on the button to perform the operation.

If you want to rotate several photos in the same direction:

· Click on the first photo to be rotated

· For each additional photo to be rotated, place the mouse over the photo and click with the mouse
while holding the <Ctrl> (or <CTRL>) "control" key in your keyboard. This will create a selection of
items (this is the same method for standard Windows program).

· Place the mouse over one of the selected photos to be rotated, and click on the desired "Rotate"
button in the "Rotate/Hide/Delete/More" Bar (as shown above).

4.3.6 How to delete/undelete a photo?

· Place the mouse is over a photo

· The Rotate/Hide/Delete/More bar will be automatically displayed for that photo to perform common
operations:

· Place the mouse over each button of this bar slowly.

· A yellow "hint" word will appear explaining the function of that button.



Photozig Albums30

Photozig (c) 2005

· When you see the desired delete/undelete function (yellow hint), click on the button to perform the
operation.

4.3.7 How to sort photos?

In Beginner and Intermediate levels:

If you want to sort the photos manually, click and hold the left mouse on the desired photo and drag to
desired position. For other sorting methods, follow these steps:

1. Click on the "View" drop-down menu in the control bar
2. Select one of these options: Tiny List, Small List, or No Thumbs List
3. Perform one of these sorting methods:

· click on Photo Title to sort by photo title.
· click on File Name to sort by file name.
· click on Date to sort by photo date.
· click on Dimensions to sort by dimensions.
· click on Size to sort by size.

In Advanced level, you have several possibilities:

· Follow the same method described above
· Click on the "Sort" drop-down menu in the control bar and select desired sort
· Click and hold the left mouse on the desired photo and drag to desired position

4.3.8 How to move photos to another album?

Click on the "Move/Copy" button in the Photos screen and follow instructions.

4.3.9 Where are my photos?

Photos that are transferred from an external device (such as digital camera, scanner, memory card,
removable media, etc.) are stored in the photo storage area. The default location is "My
Documents/Photozig Albums". You can choose a different photo storage location by clicking on
"Options" in the Home screen, "Storage" tab, and "Change Storage Folder".

When you create an album with photos that are already stored in the computer hard disk, the photos
are not copied in order to save disk space (the photos stay in the original folder location), but you can
fully manage your photos after the "Get Photos" step.

4.4 Details Screen

The Details screen shows a photo of an album. Here, you can see and edit a photo. It also provides
easy access to the details of a photo, such as photo title and description and other useful operations,
such as printing and emailing a photo.

You can also see the photo in full screen, by clicking on the Full Screen button.

Besides viewing a photo, you can also edit a photo directly, if desired. The program always keeps your
original photo and saves all your editing automatically. You don't need to worry about saving your
edited photos.
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The Editing Tools panel allows you to go back to your original photo quickly (by clicking on the Photo
drop-down menu and selecting Original) or undo an editing (by clicking on the Undo button).

Photozig Albums tracks all your editing, so you can undo editing operations on a photo even after you
close and re-start the program.

Many other functions are available in this screen, depending on the selected program level:

· Beginner: basic view and operations on photos (see details)

· Intermediate: enhanced view of photos with Albums navigator on the left panel, with filtering and
more options(see details)

· Advanced: fully customized view of photos with more sorting capabilities and other functions
(see details)

You can go to the Details screens by clicking on the Details tab or double clicking on photo in the
Photos screen.

4.4.1 Details Screen (Beginner)

The Details screen displays a full photo with the key features to view and edit a photo:

Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:
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· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

Control Bar:

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Description: here you can show or hide (vertically or horizontally) the description panel. Each photo
can have a description assigned to it. The description is always saved when you move to another
photo.

Photo: it displays the current photo

Photo Title: here you can type a title for the photo. Simply hit Enter to go to the next photo, type its title
and so on. The titles are always saved.

Photo Description: you can attach a description to any photo in Photozig Albums. Just make sure the
Description control is in the Vertical or Horizontal position. To close the description panel, change the
control to Hide or click the close ("x") button at the top right corner of the description panel

Next/Previous Photos and Rotate/Hide/Delete/More Bar

The arrow buttons allow to navigate to the next or previous photos in the album. You can also navigate
with the arrow keys and with the mouse wheel.

Use the other buttons to rotate the current photo to the right or to the left, to hide it or to delete it.
Hidden/deleted photos can be identified by an "H" letter near the buttons (for hidden photos) or an "X"
letter near the buttons (for deleted photos).

Editing Tools:

· Photo: When you modify a photo with Photozig Albums, the original photo is never affected. You
can always go back to the original photo. Whenever you edit a photo, this control changes to
Modified. If you change it back to Original the original photo is restored; if you change to Modified the
edited version is displayed. You can click on the Photo label to quickly switch between the original
and edited versions of the photo.

· Zoom: You can control the size of the photo in the editor by dragging the sliding knob with the
mouse. Notice that you can pan the photo by dragging it with the mouse.

· Fit to Screen: By pushing this button, the current photo's zoom is adjusted in a way that the photo
fits entirely into the screen. If the photo is smaller than the screen, it will be stretched on the display

· Actual Size: This button displays the photo in its actual resolution (no stretching, no shrinking)
· Crop: Allows you to crop the photo. A rubberband-like box is drawn on the picture; you can drag the

crop box by its handles until the desired section of the photo is framed by it. Then push the apply
button to keep the cropping or cancel to ignore it. Notice that under the crop button various photo
sizes can be chosen: the cropping rectangle is sized in a way that keeps the proportion of the
selected photo size

· Red-eye: When the photo subjects have red-eyes (caused by flash) you can use our red-eye tool to
eliminate them: push the red-eye button, drag a box around the red eye (in some cases more than
one red-eye can be fixed with a single rectangle), adjust the sliding knob for correction strength and
press the Keep button (or Discard). The Red-Eye tool remains active so that it is easier to fix all the
photos with red-eye without having to press the red-eye button for each one. When finished, click the
same Red-Eye button (which when red-eye is active has its label changed to End Red-Eye).
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· Quick Fix: Auto-adjusts both brightness and contrast in a single click to optimize luminance
distribution on the photo. Very useful for photos that are overall too dark or overall too bright

· Brightness: Manual brightness adjustment. You can either drag the sliding knob or push (and hold)
the plus and minus buttons

· Contrast: Manual contrast adjustment. You can either drag the sliding knob or push (and hold) the
plus and minus buttons

· Undo: Undoes the last edit operation. Notice that the undo buffer is persistent, that is, if you go to
another photo and then comes back to the edited one, the undo operation list will still be applicable

· Redo: Redoes the last undone edit operation

Notice that all editions done to a photo are saved when you change to another photo. If you come back
to a previously edited photo you can rollback each edition by pressing the Undo button, or by selecting
Original in the Photo drop down list.

Function Buttons:

· Full Screen: switches to Full Screen Mode, taking advantage of all viewable area of your monitor to
display your photo in a larger area with only essential controls shown in screen.

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.

· More...: displays a menu with options available for the photo. You can also click an photo with the
right button of your mouse to get the same menu.

Full Screen Mode:

The Full screen mode displays your photo in a larger area with only essential controls. You can click on
the Full Screen (in Function Buttons) or double-click on a photo to go to the Full Screen Mode.

When done viewing or editing the photos in full screen mode, click the close button (top right "x"
button) or hit the Escape key to go back to normal size edition. You can also double click on the edited
image to quickly toggle between full screen and regular edition mode.

You can go to the Details screens by clicking on the Details tab or double clicking on a photo in the
Photos screen.

See more information about the Details Screen.

4.4.2 Details Screen (Intermediate)

The Details screen displays a full photo with the key features to view and edit a photo:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

Control Bar:

· Show hidden: shows or hides (if unchecked) the hidden photos in the current album
· Show deleted: shows or hides (if unchecked) the deleted photos in this album

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Tools: allows you to select desired tools to work on the photo: "Edit", "Thumbnails", and "Tags":

· "Edit Tools" displays a panel with the edit tools described below
· "Thumbnails" displays a strip with all the visible thumbnails in the album. You can click on the

thumbnails to select photos to edit;
· "Tags" displays a list of tags you can you to mark your photos for quickly finding them in the future.

· Description: here you can show or hide (vertically or horizontally) the description panel. Each photo
can have a description assigned to it. The description is always saved when you move to another
photo.
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Photo: it displays the current photo

Photo Title: here you can type a title for the photo. Simply hit Enter to go to the next photo, type its title
and so on. The titles are always saved.

Photo Description: you can attach a description to any photo in Photozig Albums. Just make sure the
Description control is in the Vertical or Horizontal position. To close the description panel, change the
control to Hide or click the close ("x") button at the top right corner of the description panel

Next/Previous Photos and Rotate/Hide/Delete/More Bar

The arrow buttons allow to navigate to the next or previous photos in the album. You can also navigate
with the arrow keys and with the mouse wheel.

Use the other buttons to rotate the current photo to the right or to the left, to hide it or to delete it.
Hidden/deleted photos can be identified by an "H" letter near the buttons (for hidden photos) or an "X"
letter near the buttons (for deleted photos).

Editing Tools:

· Photo: When you modify a photo with Photozig Albums, the original photo is never affected. You
can always go back to the original photo. Whenever you edit a photo, this control changes to
Modified. If you change it back to Original the original photo is restored; if you change to Modified the
edited version is displayed. You can click on the Photo label to quickly switch between the original
and edited versions of the photo.

· Zoom: You can control the size of the photo in the editor by dragging the sliding knob with the
mouse. Notice that you can pan the photo by dragging it with the mouse.

· Fit to Screen: By pushing this button, the current photo's zoom is adjusted in a way that the photo
fits entirely into the screen. If the photo is smaller than the screen, it will be stretched on the display

· Actual Size: This button displays the photo in its actual resolution (no stretching, no shrinking)
· Crop: Allows you to crop the photo. A rubberband-like box is drawn on the picture; you can drag the

crop box by its handles until the desired section of the photo is framed by it. Then push the apply
button to keep the cropping or cancel to ignore it. Notice that under the crop button various photo
sizes can be chosen: the cropping rectangle is sized in a way that keeps the proportion of the
selected photo size

· Red-eye: When the photo subjects have red-eyes (caused by flash) you can use our red-eye tool to
eliminate them: push the red-eye button, drag a box around the red eye (in some cases more than
one red-eye can be fixed with a single rectangle), adjust the sliding knob for correction strength and
press the Keep button (or Discard). The Red-Eye tool remains active so that it is easier to fix all the
photos with red-eye without having to press the red-eye button for each one. When finished, click the
same Red-Eye button (which when red-eye is active has its label changed to End Red-Eye).

· Quick Fix: Auto-adjusts both brightness and contrast in a single click to optimize luminance
distribution on the photo. Very useful for photos that are overall too dark or overall too bright

· Brightness: Manual brightness adjustment. You can either drag the sliding knob or push (and hold)
the plus and minus buttons

· Contrast: Manual contrast adjustment. You can either drag the sliding knob or push (and hold) the
plus and minus buttons

· Undo: Undoes the last edit operation. Notice that the undo buffer is persistent, that is, if you go to
another photo and then comes back to the edited one, the undo operation list will still be applicable

· Redo: Redoes the last undone edit operation

Notice that all editions done to a photo are saved when you change to another photo. If you come back
to a previously edited photo you can rollback each edition by pressing the Undo button, or by selecting
Original in the Photo drop down list.

Thumbnails Navigator:
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The Thumbnails Navigator shows a strip with all the visible thumbnails in the album. You can click on
the thumbnails to select photos to view or edit in the Details screen.

Tags Panel:

If you click on the Tools drop-down menu in the Control Bar, the Tags Panel will appear on the left
side, allowing you to place tags on the photo quickly. This panel is also useful to review the tags of a
photo or to untag a photo.
You can also add new tags, and rename or delete existing tags (creating a personalized tag list).

Function Buttons:

· Full Screen: switches to Full Screen Mode, taking advantage of all viewable area of your monitor to
display your photo in a larger area with only essential controls shown in screen.

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.

· More...: displays a menu with options available for the photo. You can also click an photo with the
right button of your mouse to get the same menu.

Full Screen Mode:

The Full screen mode displays your photo in a larger area with only essential controls. You can click on
the Full Screen (in Function Buttons) or double-click on a photo to go to the Full Screen Mode.

When done viewing or editing the photos in full screen mode, click the close button (top right "x"
button) or hit the Escape key to go back to normal size edition. You can also double click on the edited
image to quickly toggle between full screen and regular edition mode.

You can go to the Details screens by clicking on the Details tab or double clicking on a photo in the
Photos screen.

See more information about the Details Screen.

4.4.3 Details Screen (Advanced)

The Details screen displays a full photo with the key features to view and edit a photo:
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Windows Controls: standard Windows application buttons to maximize, hide, and close the program.

Contact us Button: click on this button to get in touch with us and send a problem report, suggestion or
question.

Album Name: shows the name of the album with the number of photos inside parenthesis.

Navigation Bar:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

· Main screen tabs: Home, Albums, Photos, Details, and Share

Control Bar:

· Show hidden: shows or hides (if unchecked) the hidden photos in the current album
· Show deleted: shows or hides (if unchecked) the deleted photos in this album

· Previous photo: goes to the previous photo
· Next photo: goes to the next photo

· Tools: allows you to select desired tools to work on the photo: "Edit", "Thumbnails", and "Tags":

· "Edit Tools" displays a panel with the edit tools described below
· "Thumbnails" displays a strip with all the visible thumbnails in the album. You can click on the

thumbnails to select photos to edit;
· "Tags" displays a list of tags you can you to mark your photos for quickly finding them in the future.

· Description: here you can show or hide (vertically or horizontally) the description panel. Each photo
can have a description assigned to it. The description is always saved when you move to another
photo.
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Photo: it displays the current photo

Photo Title: here you can type a title for the photo. Simply hit Enter to go to the next photo, type its title
and so on. The titles are always saved.

Photo Description: you can attach a description to any photo in Photozig Albums. Just make sure the
Description control is in the Vertical or Horizontal position. To close the description panel, change the
control to Hide or click the close ("x") button at the top right corner of the description panel

Next/Previous Photos and Rotate/Hide/Delete/More Bar

The arrow buttons allow to navigate to the next or previous photos in the album. You can also navigate
with the arrow keys and with the mouse wheel.

Use the other buttons to rotate the current photo to the right or to the left, to hide it or to delete it.
Hidden/deleted photos can be identified by an "H" letter near the buttons (for hidden photos) or an "X"
letter near the buttons (for deleted photos).

Editing Tools:

· Photo: When you modify a photo with Photozig Albums, the original photo is never affected. You
can always go back to the original photo. Whenever you edit a photo, this control changes to
Modified. If you change it back to Original the original photo is restored; if you change to Modified the
edited version is displayed. You can click on the Photo label to quickly switch between the original
and edited versions of the photo.

· Zoom: You can control the size of the photo in the editor by dragging the sliding knob with the
mouse. Notice that you can pan the photo by dragging it with the mouse.

· Fit to Screen: By pushing this button, the current photo's zoom is adjusted in a way that the photo
fits entirely into the screen. If the photo is smaller than the screen, it will be stretched on the display

· Actual Size: This button displays the photo in its actual resolution (no stretching, no shrinking)
· Crop: Allows you to crop the photo. A rubberband-like box is drawn on the picture; you can drag the

crop box by its handles until the desired section of the photo is framed by it. Then push the apply
button to keep the cropping or cancel to ignore it. Notice that under the crop button various photo
sizes can be chosen: the cropping rectangle is sized in a way that keeps the proportion of the
selected photo size

· Red-eye: When the photo subjects have red-eyes (caused by flash) you can use our red-eye tool to
eliminate them: push the red-eye button, drag a box around the red eye (in some cases more than
one red-eye can be fixed with a single rectangle), adjust the sliding knob for correction strength and
press the Keep button (or Discard). The Red-Eye tool remains active so that it is easier to fix all the
photos with red-eye without having to press the red-eye button for each one. When finished, click the
same Red-Eye button (which when red-eye is active has its label changed to End Red-Eye).

· Quick Fix: Auto-adjusts both brightness and contrast in a single click to optimize luminance
distribution on the photo. Very useful for photos that are overall too dark or overall too bright

· Brightness: Manual brightness adjustment. You can either drag the sliding knob or push (and hold)
the plus and minus buttons

· Contrast: Manual contrast adjustment. You can either drag the sliding knob or push (and hold) the
plus and minus buttons

· Undo: Undoes the last edit operation. Notice that the undo buffer is persistent, that is, if you go to
another photo and then comes back to the edited one, the undo operation list will still be applicable

· Redo: Redoes the last undone edit operation

Notice that all editions done to a photo are saved when you change to another photo. If you come back
to a previously edited photo you can rollback each edition by pressing the Undo button, or by selecting
Original in the Photo drop down list.

Thumbnails Navigator:
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The Thumbnails Navigator shows a strip with all the visible thumbnails in the album. You can click on
the thumbnails to select photos to view or edit in the Details screen.

Tags Panel:

If you click on the Tools drop-down menu in the Control Bar, the Tags Panel will appear on the left
side, allowing you to place tags on the photo quickly. This panel is also useful to review the tags of a
photo or to untag a photo.
You can also add new tags, and rename or delete existing tags (creating a personalized tag list).

Function Buttons:

· Full Screen: switches to Full Screen Mode, taking advantage of all viewable area of your monitor to
display your photo in a larger area with only essential controls shown in screen.

· Edit Photo: opens the current photo for edition. You can also open the photo by double-clicking it
with the mouse or by hitting the Enter  key.

· Play Slideshow: displays the photos as a full-screen slide show. If you have songs stored in your
computer you can play selected tracks along with the slide show. The slide show order will be the
same of the photos in the album, and it starts with the currently active photo.

· Print: allows you to print photos in the album.

· More...: displays a menu with options available for the photo. You can also click an photo with the
right button of your mouse to get the same menu.

Full Screen Mode:

The Full screen mode displays your photo in a larger area with only essential controls. You can click on
the Full Screen (in Function Buttons) or double-click on a photo to go to the Full Screen Mode.

When done viewing or editing the photos in full screen mode, click the close button (top right "x"
button) or hit the Escape key to go back to normal size edition. You can also double click on the edited
image to quickly toggle between full screen and regular edition mode.

You can go to the Details screens by clicking on the Details tab or double clicking on a photo in the
Photos screen.

See more information about the Details Screen.

4.4.4 How to rotate a photo?

· The Rotate/Hide/Delete bar will be automatically displayed on the left bottom corner of the photo to
perform some common operations:

· Place the mouse over each button of this bar slowly.

· A yellow "hint" word will appear explaining the function of that button.

· When you see the desired rotate function (yellow hint), click on the button to perform the operation.
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4.4.5 How to edit a photo?

In Beginner level:

· Use the controls of the Editing Tools on the left panel.

In Intermediate and Advanced levels

· If you don't see the Editing Tools on the left panel, click on the "Tools" drop-down menu in the
control bar and select Edit.

· Use the controls of the Editing Tools on the left panel.

If you edit a photo, the program always keeps the original and saves your modifications, so you don't
need to worry about saving the edited photo.

The Editing Tools panel allows you to go back to your original photo quickly (by clicking on the "Photo"
drop-down menu and selecting Original) or undo an editing (by clicking on the "Undo" button).

4.4.6 How to see other photos?

· To see photos in the same album, click on the "Photos" tab in the top navigation bar.

· To see photos from another album, click on the "Albums" tab in the top navigation bar and double-
click on the desired album.

4.5 Share Screen

The Share screen shows different ways to share your photos:

· Publish and manage web albums

· Send photos via e-mail

· Create Screen Saver

· Copy photos to CD

· Copy photos to folder or memory card

Just select the desired share method and the wizard will guide you step by step.
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5 Navigating the Program

You can navigate throught the program by using the following:

· Navigation Bar
· Jump To Menu
· Wizard Navigation
· Other ways to navigate

5.1 Navigation Bar

The Navigation Bar allows you to Navigate through the program easily:

· Left arrow: goes to previous screen
· Right arrow: goes to next screen
· Question mark: help

You can also go to the main screens of the program by clicking on the appropriate tab:

· Home: goes to the Home screen, which is the main screen of the program, allowing access to
several functions.

· Albums: goes to the Albums screen, showing a list of your albums.

· Photos: goes to the Photos screen with the photos your a selected album.

· Details: goes to the Details screen, which shows a photo in a selected album. In this screen you can
also edit a photo.

· Share: goes to the Share screen with different options to share your photos.

5.2 Jump To Menu

The Jump To Menu is visible with the program levels: Intermediate and Advanced
(how to change the program level).

The Jump To Menu is located on the top right corner of the program screen. You can click on the
"Select..." field to choose the desired shortcut destination:

· All Albums: shows a list of all your albums.

· All Photos: this album contains all photos from all albums that you created. This album is very
useful when you want to look for particular photos quickly or perform some operations with all your
photos.

· Favorites: shows your favorite albums

· Get Photos: goes to the "Get Photos and Make Albums" wizard.
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· Last Seen: shows the list of albums that were last seen.

· Photo Basket: this is a temporary album which may contain photos from different albums. This
might be handy, as you can send photos to the Photo Basket when you are browsing your albums
and perform an operation in this photo set, such as play a slide show, create a screen saver, email
or send to a web album. When you send photos to the Photo Basket, the photos actually stay in the
original albums, but are referred or accessed in the Photo Basket.

5.3 Wizard Navigation

The Wizards in Photozig Albums have 3 main buttons located in the right bottom corner of the screen:

· Back: goes back to the previous screen

· Next: goes to the next screen

· Cancel: leaves the wizard operation and cancels the wizard operation

Depending on the nature of the desired operation of the wizard at a certain step, you may see some
other buttons, check boxes, or input fields in the middle of the screen, which are used to perform key
operations, select options, or input information.

5.4 Other ways to navigate

You can also go to the Home screen and select the appropriate function.
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6 Transferring photos

You can transfer the photos to the Photozig Albums program by these methods:

· Scan your computer
· Get Photos
· Copy from Other Programs
· Drag/Drop from Internet Explorer and Others

6.1 Scan Your Computer

After installing Photozig Albums for the first, you will be asked if you want to scan the computer for
photos. If you replied "Yes", the program will search will look for photos in all folders of your hard disk.
In this process, you have the option to ignore photos with small dimensions (which could be banners
and other web graphics) and/or create multiple albums based on dates or folders.

You can also click on "Tools" in the Home screen and click on the button "Search Computer for
Photos..." to start the scanning process at any time.

6.2 Get Photos

There are several ways to start the Get Photos wizard which will guide through the Get Photos
process:

· In the Home screen, click on the "Get Photos" icon

· In the Albums screen, click on the "Get Photos" button

· In the "Jump to" drop-down menu {Intermediate, Advanced}, select "Get Photos"

The next are to follow the Get Photos wizard to transfer photos to Photozig Albums.

6.3 Copy from Other Programs

You can use the standard Windows key combination "<Ctrl>-C" to copy an image from other programs
(or click on "Copy" in the "Edit" menu) and paste the image directly in the Photos screen of Photozig
Albums.

6.4 Drag/Drop from Internet Explorer and Others

You can drag and drop most images from Internet Explorer [Deluxe, Premium]. First select the desired
photo by clicking on the image on the web page, then drag this image with the mouse into the
Photos screen of Photozig Albums. The image will be included in the current photo album.

Photos in some web pages may be protected, which will require to copy the photo (mouse right click on
the image and select "Copy") and paste the photo in the Photos screen of Photozig Albums (mouse
right click and select "Paste".

You can also drag and drop image files from Windows Explorer into the Photos screen of Photozig
Albums. It is also possible to copy an image file and paste it in the Photos screen.
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7 Organizing Your Photos

7.1 Albums structure

You photos are organized in photo albums shown in the Albums screen. There are different ways to
view, sort, and filter your album collection depending on the program level. (See more details)

7.2 All My Photos Album

You can see all the photos in the "All My Photos" album, which contains all photos from all albums that
you created.

7.3 Photo Basket

The "Photo Basket" is a temporary album which may contain photos from different albums (the photos
actually stay in the original albums). This virtual album may be useful when you want to do a quick
selection of photos in different albums and perform an operation in this photo set, such as play a slide
show, create a screen saver, email or send to a web album.

7.4 Sorting photos

In the Photos screen you can sort and filter photos by using different criteria. Photos can also be
associated with tags, so you can quickly select photos that belong to the same style or theme.

Besides photo tagging, Photozig Albums provides Albums categories in the Albums screen, allowing
you to classify albums according to your personal classification method (e.g. by dates, by album type,
etc.)

7.5 Tags

Photozig Albums allows you to create Tags for the photos {Intermediate, Advanced}.

Tags can be easily created and associated with your photos. You can work with Tags in the
Photos screen or Details screen by clicking on the "More" button and selecting "Tags".

Later on you can choose to display only the photos that are associated with certain tags. Each photo
can be associated with as many tags as you wish.

You can filter photos based on Tags criteria by clicking on "Filter" and choosing Tags in the
Albums screen or Photos screen.
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8 Working with Folders

8.1 Conventional Folders Use

You can browse the photos in the folders of your computer hard disk by clicking on "Browse Folders" in
the Home screen, which will show the Folders view mode in the Photos screen with Folders on the left
panel and pictures on the right panel.

By right clicking the mouse on a folder on the Folder (left) panel, you can rename, delete or create a
new folder.

You can also perform many operations on photos in folders, e.g. browse, edit, slide show, send to web,
email, etc. However more features are provided for photos that stored or indexed by albums created
by Photozig Albums. (How to create an album)

Therefore, we highly recommend you to:

· Create an album with photos from a folder, by clicking on the button "Create Album from Folder", or

· Add photos to an album, by clicking on the button "Add photos to Album".

Both buttons are located on the lower bar of the program screen.
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9 Creating and Playing Slide Shows

Photozig Albums creates slide shows from single albums automatically, when you click in the button
"Play Slide Show" in the bottom bar of the screens: Albums, Photos or Details.

You can also create slide shows from multiple albums [Deluxe, Premium] by clicking on "Slide Show"
icon in the Home screen and following instructions of the wizard.

9.1 Slide Show Controls

When you are watching a slide show, the right corner displays controls you can use to change the way
the photos are displayed. Notice that the controls disappear after a few moments to that you can watch
your photos without disturbing controls on the screen.

During a slide show, if you move the mouse to the right top upper corner, you will see slide show
controls again.

The following controls are available:

Timer counter: the first control displays an animated pie graphic reflecting the duration of each slide

Volume control: you can change the volume, in case a sound track is played, by changing the sliding
volume control. Press the Mute (speaker icon) to mute the sound.

Play/pause: push this button to play or pause the slide show. Notice that on pause the sound track is
paused as well. You can also use the space bar in the keyboard for the same effect

Left/Right arrow: move to the previous or next photo immediately. You can also use the left and right
arrow keys for the same effect

Slide Time Control: select the photo interval time by sliding this control.

Options: click on this icon to decide whether to have transitions between photos and if movie clips
should be played during the slide show (or simply the first frame), to manage the slide show's sound
track list, pause sound track, and select loop, random and stretch/crop options.

X button: Closes the slide show. You can also use the Escape key to achieve the same function
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10 Sharing photos online

Sharing photos online is simple with these possibilities:

· Send photos to online web albums

· Email photos

10.1 Web albums

You can share photos online easily, by using one of these options:

In the Home screen, click on the "Send photos to web" icon.

In the Albums screen, click on the button "Send To Web" in the lower bar of the screen.

In Photos screen, select the photos you want to send by holding the key <Ctrl> while left clicking with
the mouse on the desired photo, and right click on a selected photo choosing "Send to > Web".

In the Share screen, select "Send photos to web and manage web albums" and click "Next" button.

By using one of these options, you will start the Send to Web Wizard. You just need to select the
desired operation and follow instructions.

10.2 Email photos

You can share photos online easily, by using one of these options:

In the Home screen, click on the "Email" icon.

In Photos screen, select the photos you want to send by holding the key <Ctrl> while left clicking with
the mouse on the desired photo, and right click on a selected photo choosing "Send to > Email".

In the Share screen, select "Send photos via e-mail" and click on the "Next" button.

By using one of these options, you will start the Email Wizard. You just need to follow the instructions.
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11 Creating Screen Saver and Wallpaper

11.1 Screen Saver

Click on the "Share" icon in the Home screen, select "Create Screen Saver", click on the "Next" button,
and follow instructions to create a Screen Saver.

11.2 Wallpaper

In the Photos screen or Details screen, right click with the mouse on the desired photo for wallpaper,
select "Send To > Wallpaper", and choose the desired wallpaper type.
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12 Managing music

Photozig Albums can play songs in your slide shows. First, you have to let Photozig Albums know
where your songs are. In order to manage your music, go the Home screen, and click on "Tools" under
the "Extras" icon to open the Sound Tracks Manager which will allow you:

· Add, delete, or rename categories of sound tracks.
· Add, remove, or rename songs in your sound track categories.
· Browse your computer for music and play songs.

See more information about the Sound Track Manager

After you added songs using the Sound Track Manager, you can select songs for your slide shows
using the Slide Show Track Manager.

12.1 Sound Tracks Manager Screen

Photozig Albums allows you to organize sound files into categories and then use you sound files as
sound track for slide shows.

The top of the Sound Tracks Manager displays the current categories organized as in a tree structure.

· To add more categories under the selected category, click "Add New Category..."

· To delete a category, select it and click "Delete Category..."

· To change the name of a category, select it and click "Rename Category..."

The bottom of the Sound Tracks Manager displays the songs stored in the category you selected in the
top portion of the screen.

· To add songs to the selected category, click "Add Songs..." and select the songs you want to
include

· To remove a song from the selected category, select it and click "Remove Song"

· To rename a song, select it and click "Rename Song..". Notice that the song file is not affected.
Only the name of the song in Photozig Albums

· To play a song, double click it or click the green play arrow button

· To pause a song, click on the pause button (pause signal button)

· To stop a song, click on the stop button (black square button)

· To change the playback volume, click on the speaker button and move the sliding control that
pops up

You can move songs between categories by dragging them from the song list onto the desired
category.
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12.2 Sound Track of a Slide Show

Photozig Albums allows you to select a collection of music files to use as sound track for a specific
slide show.

To choose the sound tracks of a Slide Show, click on the options icon in the right top corner of the slide
show, and click on the "Sound Track" button, which will open the Slide Show Track Manager.

The top of the Slide Show Track Manager displays the current music files in use by the slide show.

The bottom portion of the same screen displays the tracks that are available to use in the slide show.

· To see the songs available in a category, click on the category in the categories tree view

· To use a song in the slide show sound track, select it and click on "Use track in album", or simply
drag the song file onto the list of tracks in the album (top panel)

· To play a song, double click it or click the green play arrow button

· To pause a song, click on the pause button (pause signal button)

· To stop a song, click on the stop button (black square button)

· To change the order the songs are played, use the Move Up and Move Down buttons or drag the
songs names within the list (top panel)

· To remove a song from a slide show, select it in the top list and click on "Do not use track in album"

· To add/remove/manage songs in the system, click on "Manage Music"
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13 Copying photos to Cd or other media

There are different possibilities to export or copy photos to different types of media:

· Copy to CD.
· Copy to folder or memory card.
· Send to Folder/Media directly.

13.1 Copy to CD

To copy photos to CD, click on the Share tab of the Navigation Bar to go to the Share screen, select
"Copy photos to CD", click on the "Next" button, and follow instructions.

13.2 Copy to folder or memory card

To copy photos to folder or memory card, click on the Share tab of the Navigation Bar to go to the
Share screen, select "Copy photos to folder or memory card", click on the "Next" button, and follow
instructions.

13.3 Send to Folder/Media directly

To send to Folder/Media directly, select the desired photo or photos, in the Details screen or
Photos screen, right click the mouse on the photo, select "Send To > Folder/Media", choose one of the
most recent folders or "Browse..." to choose a different folder, and follow instructions.
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14 Moving your photo storage

14.1 How photos are stored

New photos captured by Photozig Albums are stored in the photo storage folder of the program.

14.2 Changing the photo storage location

To move the photo storage to a different folder or hard disk, click on the "Options" icon in the
Home screen, select the tab "Storage", click on the "Change Storage Folder...", and follow instructions.
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15 Program Options

To select the options of Photozig Albums, click on the "Options" icon in the Home screen.

You can select the following options:

· Enable Photozig Media Detector: loads an automatic media detector (shown in the system tray),
which alerts you when it detects an insertion of media, such as a memory card, and enables you to
launch Photozig Albums directly from the system tray (right bottom of the desktop) to capture the
photos in the memory card or to access other functions of Photozig Albums.

· Launch explorer from photo info boxes: shows a "link" in the information panel of Photo Info (File
Name field). By clicking in the link of the file name, Photozig Albums will launch the Windows
Explorer and show the folder where the file is located (the photo file is also highlighted).

· Remember zoom of each edited photo: will keep the zoom factor of each factor. If this option is
not selected, Photozig Albums will resize the photo in the Details screen to fill all viewable area. If
the option is selected, the program will retain the user zoom factor for each photo and will not resize
it to fill the viewable area when photos are loaded.

· Allow deletion of photos outside photo storage area: when you ask the program to remove
deleted photos permanently, it will check this option. If selected, the program will erase photos that
were originally stored outside Photozig Albums storage area (most likely by another program). It is
recommended to not to have this option selected to protect photos outside the program storage
area, because these images might be used by other programs.

· Check for program updates when program starts: if this option is selected, the program will
contact the Photozig server and check for updates automatically every time Photozig Albums starts.
If there is an update available, the program will tell you about these updates, and you can decide
whether or not to download and install the updates. It is recommended to have this option selected.

15.1 Show Hint Dialogs

In the Options screen, you can reactivate program hints:

· Show Hint Dialogs: by clicking on "Show Hint Dialogs" button, you can select to reactivate all hint
dialogs of Photozig Albums, which may provide some helpful information about how to use the
program.
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16 Technical Definitions

16.1 Exif

EXIF (Exchangeable Image File)

Some cameras include extra information in each photo. Thanks to that feature, information like:

· Date and time photo was taken
· Camera make and model
· Focal length
· f-Number
· Exposure
· Aperture
· Flash was used

among other items are included in the camera files. Files that contain such information are called Exif
files.

16.2 ISP

Internet Service Provider: the company that provides you with access to the Internet

16.3 Jpeg

JPEG stands for Joint Photographic Experts Group, the original name of the committee that wrote the
standardized JPEG image compression mechanism. JPEG achieves great compression of images by
discarding information that the human eye cannot see; thus it is a lossy compression method.

JPEG compression can be adjusted so that the images take up more or less space in their storage;
however, the smaller the space they take, the lower the quality of the images. Photozig Albums uses
90% quality JPEG images to achieve optimum balance between quality and space savings.

16.4 TWAIN Drivers

There are a few methods offered by digital camera manufacturers to make the camera contents
available to applications:

· Simulate a disk drive
· TWAIN drivers
· Other methods

Photozig Albums support the two first methods, which are supported by virtually all cameras. However,
if your camera's software package offers options, we strongly recommend that you opt for exposing the
camera as a simulated disk drive, since the movie clips and EXIF information cannot be transferred
using TWAIN drivers.

If you are capturing images from scanners, the TWAIN driver is the only option available.

When capturing photos using a TWAIN driver, an extra screen will be displayed for selection of images
to transfer. Those screens are designed by the camera manufacturer's team, and not by Photozig.
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16.5 Favorite Albums

You can mark some albums as Favorites. To do that, simply click with the right button of the mouse
on the desired album and, on the menu that appears, select Add To Favorites.

When viewing albums, you have an option to view only the Favorite ones for quickly finding them.

16.6 FTP Server

An FTP Server is a location on the Web where you have a user account, space in disk allocated to you
and to which you can send and receive files.

We offer you our my.photozig.net service for you to share your photos with, but if your Internet Service
Provider allows you to send files to their own FTP Server, you can use it normally with Photozig
Albums.

16.7 Outbox

Outgoing email box: the folder where your emails sit until you decide to send them to their
destinations. In some cases the emails are sent automatically without the need to manually send them,
depending on the email application configuration.

16.8 Photo Database

The photos and movie clips in Photozig Albums are stored in a folder named Photozig Albums inside
your My Documents folder. This folder is known in the program as the Storage Folder and, if you
prefer, you can choose any other folder of your preference (usually on a disk drive with as much space
as possible), as you can configure in the Options form.

With Photozig Albums you can capture photos from any source, for instance:

· Digital Cameras
· Scanners
· Memory cards
· CDs
· DVDs
· Hard drives
· Floppy disks

All the photos (and movie clips) retrieved from removable media are copied into the Storage Folder.
Photos that are already in your hard drives will not be moved or duplicated. The photo database
creates links to them to know where they are located.

The photos transferred to the system are stored in sub-folders named after the albums that you create,
inside the storage folder. When you edit or rotate your photos, the modified versions are stored in sub-
folders of the album, so the originals are always preserved.

The program also uses several auxiliary files to manage the photo database, which are stored in the
folder Photozig Albums/Storage, inside your Application Data folder.

Important: We strongly recommend that you don't directly modify the files in the mentioned folders,
because you can corrupt the Photozig Albums database. You will not loose your photos by doing that
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(unless you tamper with the photo files themselves), but the program may behave unpredictably.

16.9 Photo Sort Order

There are two ways to sort the photos in Photozig Albums:

1. Selecting the sort order from the Sort drop down at the top of the photos {Advanced}:

You can click on the Reverse Button to reverse the sorting of the photos.

2. Clicking at the top of the columns, when the photos are viewed in list mode:

When you click on a column header, the list of photos is sorted by the header. Clicking once again
reverses the sorting.

You can sort the photos in an album by the following ways:

· Custom: If you drag the photos around with the mouse, you create you own customized order,
specific for the current album. That order is preserved by Photozig Albums as the Custom sort order.

· File Name: Photos are sorted alphabetically by their file names.

· Title: Photos are sorted alphabetically by their titles.

· Date/Time: Photos are sorted by date/time when they were taken, if that information is available
(Exif information from Jpeg files). If not available, they are sorted by the date/time of the photo files.

· File Size: Photos are sorted by their file sizes, expressed in bytes.

· Dimensions: Photos are sorted by their sizes in pixels. When Photozig Albums sorts by dimensions,
it uses only the largest of the horizontal and vertical dimensions to compare different photos.

Notice that when you switch to another album, the current sort order for the album is preserved
automatically by Photozig Albums.

16.10 Photo Tags

Photozig Albums allows you to create Tags for the photos.
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Tags are text expressions that you create and associate freely with your photos. Later on you can
choose to display only the photos that are associated with certain tags. Each photo can be associated
with as many tags as you wish.

16.11 Pixels

A PIXEL is a picture element, the smallest unit (point) of an image displayed on screen. The quality of
an image depends on the number of pixels per inch that make up the image.

One MEGAPIXEL is one million pixels. So, for instance, an image with 1600 x 1200 pixels contains
1,920,000 pixels, so we could say that the image has roughly 2 megapixels.

16.12 Preview Pane

Optionally you can display a preview pane showing the first photos of the currently selected album:

If you double-click with the mouse on a photo in the preview pane you will open the photo editor directly
on the selected photo.

To display or hide the preview, use the Show Preview check box, displayed at the top of the Albums
List.

16.13 Screen Saver

A Screen Saver is an application that protects the screen from harm due to prolonged display of a
static image.

By changing the display contents regularly, the monitor is preserved.

You can use your own photos as the images displayed in the Photozig Screen Saver. Click on the
Create Screensaver button available at the main screen of Photozig Albums to configure which photos
should be used by the screen saver.



Photozig Albums70

Photozig (c) 2005

Technical note: The screen saver is implemented by the pzssaver.exe application, which is copied to
the Windows directory in your computer.

16.14 pzSlides Application

The pzSlides.exe application is included as part of the Photozig Albums package.

This application is copied to CDs along with the photos that compose an album or a slide show, and is
used to display the photo in a CD in a target computer.

If you insert a CD that was burned with Photozig Albums in a CD-ROM drive, the application
automatically starts and displays the photos in it as a slide show. If more than one album or slide show
is included, the application displays a screen for the user to select which slide show to play.

16.15 Slide Shows

In Photozig Albums you can see photos as slide shows. A slide shows displays a sequence of photos
based on a few options:

· Duration of each photo
· Transitions between photos
· Sound track for the slide show
· Automatically play movie clips or not (if some of the photos are, in fact, movie clips)

Whenever you are viewing an album you can start a slide show for that album by pushing the Play
Slideshow button, available in several screens.

Photozig Albums offers a second type of Slide Show: the standalone slide show.

Standalone slide shows can be managed from the Slide Show button available at the main screen of
the application. With standalone slide show you can manually build a sequence of photos that are
stored in more than one album, and optionally include only photos that have certain tags associated
with them.

16.16 SMTP

Simple Mail Transfer Protocol (SMTP): a common method employed by Email servers to send
emails
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17 Activate and Upgrade the program

This function allows you to upgrade your Photozig Albums program. Click on the "Activate & Upgrade"
icon in the Home screen to see the Upgrade/Activation dialog box, where you can enter your email and
activation key. This dialog box also shows how you can get an activation key.

17.1 Advantages of upgrading

By upgrading your program, you will have more features and functions to manage your digital photos.

(Learn more about Photozig Albums product family)
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